
Customized
HMI PLC All in One
Programming Manual

Copy right: Shenzhen Coolmay Technology Co.,Ltd
V21.81



I

Content
1 Summary..................................................................................................................................1

1.1 COOLMAY MX2N PLC HMI All in one main advantage..........................................1
1.2 Type & Specification....................................................................................................2
1.3 Hardware description....................................................................................................3

1.3.1 4.3inch structure description and dimension..................................................... 3
1.3.2 7inch structure description and dimension........................................................ 4
1.3.3 Interface and Indicators description...................................................................5

1.4 PLC programming notice..............................................................................................5
2 Component Range....................................................................................................................6
3 PLC Supported instruction.......................................................................................................7

3.1 Basic Logic instructions................................................................................................7
3.2 Step command instructions...........................................................................................7
3.3 Function instruction table( Compared with Mitsubishi PLC).......................................8
3.4 Special relay & register function................................................................................ 12

3.4.1 Special relay function table..............................................................................12
3.4.2 Special register function table..........................................................................13

4 Analog Usage.........................................................................................................................15
4.1 Analog input type........................................................................................................15

4.1.1 Analog input reading........................................................................................15
4.2 Analog output type......................................................................................................16

4.2.1 Analog output reading......................................................................................16
4.3 Weighing function / load cell......................................................................................16

5 Random number instructions.................................................................................................18
6 High speed counter application..............................................................................................19

6.1 Inside high speed counter input distribution table......................................................19
6.2 High speed counter input instructions.........................................................................19

7 Pulse capture function application.........................................................................................21
8 High speed pulse output application......................................................................................22
9 Optional com port instructions...............................................................................................23

9.1 Function Description...................................................................................................23
9.2 Modbus-RTU Protocol special registers & relays...................................................... 23
9.3 D8120 Parameter and Function setting.......................................................................23
9.4 Modbus-RTU Master station instructions...................................................................24
9.5 Modbus-RTU Protocol slave station element address................................................26
9.6 RS Protocol special registers & relays instructions....................................................28
9.7 CAN communication protocol instruction..................................................................28

9.7.1 Function description.........................................................................................28
9.7.2 Register and relay description..........................................................................28
9.7.3 Description of register can’t be communicated............................................... 29
9.7.4 CAN communication speed and distance........................................................ 29
9.7.5 Master-Slave shared register table...................................................................29
9.7.6 Setting example of communication program...................................................31



II

9.7.7 Test program description................................................................................. 32
10 Fault detection........................................................................................................................1
11 HMI (Human Machine Interface)....................................................................................... 4

11.1 How to install mView software.................................................................................. 4
11.2 How to open mView software.................................................................................... 9
11.3 Build New HMI Program..........................................................................................10
11.4 Introduction of mView software interface..................................................................1

12 HMI program simulation and download................................................................................1
12.1 Program simulation.....................................................................................................1

12.1.1 On-Line Run.................................................................................................... 1
12.1.2 Off-Line Run....................................................................................................3

12.2 Program download and update O.S. version...............................................................3
12.2.1 Download to HMI............................................................................................3
12.2.2 Save as HMI program...................................................................................... 2
12.2.3 Update HMI OS...............................................................................................3

12.3 Program upload...........................................................................................................5
12.3.1 Upload HMI program...................................................................................... 5

12.4 More details, refer to Coolmay TK Series HMI User Manual ................................. 7
Appendix Version Change Record............................................................................................. 8



Customized HMI PLC all in one programming manual

1

1 Summary
1.1 COOLMAYMX2N PLC HMI All in one main advantage
◆MX2N series HMI PLC All in one ,as the first choice for automatic control of small and
medium-sized equipment,is with complete functions, stable performance, convenient maintenance,
safe and reliable.
◆ Could use GX Developer 8.52E and GX Works2 software to program, read, download, verify,
diagnose,monitor and process sequence.
◆ Could customize 6 channels AD and 2 channels DA,in 12bit precision,use RD3A to read AD
data and WRA3 to output DA data.
◆ Support optional one RS485 or RS232 COM Port,support Programming port protocol and
MODBUS-RTU master-slave protocol.It can be switched in the program through D8120,support
communication through RS485 networking and inverter etc.
◆ Support RTC function,when password is 12345678,the programming software can't modify
clock data.
◆ High Speed counter input conventional 6 channels single-phase counting (X0-X5) or 2
channels AB(Z) phase counting 10KHz, it can be customized 6 channels single-phase counting or
2 channels AB(Z) phase counting 60KHz.
◆ High speed pulse output conventional 4 channels 10KHz Y0/Y1/Y2/Y3, it can be customized 4
channels Y0/Y1 200KHz,Y2/Y3 100KHz.
◆ Support Watch dogs function-compatible with Mitsubishi FX2N.
◆ Support external interrupt function-compatible with the original,support pulse capture
function,support 6 channels X0-X5.
◆ Support super password: When password is 12345678,the program can't read except the soft
component data. When password is changed,the program will be cleaned. You can also open the
PLC program to disable the read mode on setup software (Once open, no matter what the
password is,the program can't be read.)
◆ Support Power-down data protection (All power-down is Kept by FLASH,data will be checked
when power-on.)
◆ Check the downloaded ladder program
◆When the program run in the PLC,it will check the program instructions and the components
range,corresponding problem will be reported when being detected.
◆ Run light flashes when switch turns to "RUN", run light goes out when to "STOP".
◆ During running. If check slight fault,the ERR light flashes. If serious fault,ERR light is on
always.
◆ Support constant scan: D8039-Constant scan time,M8039-Constant scan mode.
◆ 7inch Support CAN port for networking communication function. Support 32 slaves at most,up
to 32 registers master-slaves can be shared,communication baud rate could be set.
◆ Optional High speed pulse output function, PWM support the highest frequency 900KHz,duty
ratio is -100%.
◆ 4.3inch Support function of thermocouple temperature measuring: automatic cold junction
compensation,could connect 2 channels K/E/J thermocouple at most, could measure negative
temperature.
◆ Support function of program limit : could select clock date limit,power-up cumulative time
limit.
◆ Support function of NTC thermistor to measure temperature,support NTC of 10K,50K,which B
value is 3950.
◆ 7inch is optional to add 1 channel load cell function (occupy AD0-AD2).
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1.2 Type & Specification
Type 4.3 inch 7 inch

Image

Dimension 134*102*34mm 210*146*36mm
Cutout size 120*94mm 192*138mm

HMI
Features 60K colors resistive panel, can be vertical display

Display type 4.3"TFT 7.0"TFT
Display size 97*56mm 154*87mm
Resolution 480*272pixels 800*480pixels
RAM NOR Flash 8MB NOR Flash 16MB
ROM 64MB

Operation
system NULL

CPU 32bit CPU 408MHz

COM port Type-C; PLC program can be downloaded through the penetration function of the HMI
1 RS232 Optional 1 RS232 or 1 RS485 Optional

Software mView
PLC

Digital I/O 12DI/12DO 24DI/20DO (Up to 17 relay)

I/O level
Output MT: low level NPN, COM connected to negative;

output MR: normally open dry contact;
Input: Passive NPN, common terminal isolation

Digital output
and load

MT is MOS tube output, MRT is mixed
output

MOS: 2A/point, 4A/4-point COM,
5A/12-point COM;

MR: 2A/point, 5A/12point COM

Y0-Y3 are MOS tubes, and the others are MT.
MRT is a mixed output (where Y13, Y14, Y15

are fixed as transistors)
MOS tube: 2A/point, 4A/4point COM;
MT: 0.5A/point, 0.8A/4point COM;
MR: 2A/point, 4A/4 points COM.

High speed
Counting

Normally 6 single phase counting (X0-X5) or 2 AB(Z) phase counting10KHz
can be customized as 6 single phase counting

or 2 AB(Z) phase counting 60KHz
High speed

Pulse
Normally 4 channels 10KHz，Y0-Y3

can be customized as 2 channels 200KHz and 2 channels 100KHz

Analog I/O

AI:0-5V/0-10V/0-20mA/NTC10K/
NTC50K/EKJ

(NTC type and thermocouple type cannot
coexist)

AI:-5-5V/-10-10V/0-5V/0-10V/
0-20mA/NTC10K/NTC50K

AO:0-10V/0-5V/0-20mA or mixed
Max 4AD/2DA

(NTC and thermocouple each analog will
occupied 2 channels)

Max 6AD/2DA
Optional: 1 channel load cell (occupy AD0-AD2)

Optional: Max 3channels NTC

Com port

Default with RS232 programming port

Optional: 1 RS485 (can’t coexist with
built-in RS232)

Optional 1 RS485 (cannot coexist with the
built-in RS232)
Optional CAN (only for internal networking, not
coexist with the load cell)

Software Compatible with GX Developer8.52和 GX Works2
Suggested model: 4.3 inch-24MR/24MT (-4AD2DA-232H)

7 inch-24MR/24MT/44MRT/44MT(-6AD2DA-485P/232H)
485P means optional 485 on PLC; 485H/232H means optional 485/232 on HMI

Detailed info. refer to: <Customized HMI PLC all in one Programming Manual>
<Customized HMI PLC All In One User Manual> <Coolmay TK series HMI User Manual>

file:///C:/Users/Administrator/Desktop/javascript:void(0);
https://en.coolmay.com/Download.aspx?ColumnId=159&Language=36&Terminal=41
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1.3 Hardware description
1.3.1 4.3inch structure description and dimension

PLC Run light Com port of plc and hmi Power light

* Dimension(mm)：134*102*34
* Cutout size(mm)： 120*94
* Display size(mm): 97*56
* Installation: Clip installation
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1.3.2 7inch structure description and dimension

PLC Run light Com port of plc and hmi Power light

* Dimension(mm)：200×146×36
* Cutout size(mm)： 192×138
* Display size(mm): 154×87
* Installation: Clip installation
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1.3.3 Interface and Indicators description

POWER：Power indicator, light on when connected to power
RUN：PLC operating status indicator, the lamp is on when PLC is running
COM：HMI Touch screen and PLC communication status indicator, light on when
communicated
Power terminal: The positive and negative poles of the DC24V switch power supply
are connected to the DC24V and 0V power terminals.
PLC programming port: download plc program by 232 programming line
HMI programming port: Download hmi touch screen configuration program

1.4 PLC programming notice.
The PLC is compatible with GX 8.52E/Works 2 etc. If you use other versions of the software,
incompatibility may occur.

When the PLC program is downloaded, there is a prompt error: Cannot specify the com port,
GX 8.86 software: Online - Transfer settings change com port;
Works 2: All targets - Change the com port in all connected targets;

If communication error occurs, cable is abnormal If prompted, remove it by powering off,
detecting the cable, detecting whether the power is normal, or replacing the computer.

In the GX Developer8.52E,choose the figure :

In the Works 2 software version, choose the figure : (Note: the label is forbidden)
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2 Component Range

Input X X0~X47 40 points Out put Y Y0~Y47 40 points

Ministrant
relay M

M0~M499
500
points

(general)

M500~M1535 1036 points
(keep)

M8000~M8255 255
points (special)

State relay
S

S0~S9 10 points
(State keep) S10~S999 990 points (keep)

Timer T
T0~T199
200 points
100ms

T200~T254
46 points
10ms

T246~T249
4points 1ms
accumulation

T250~T255 6points
100ms accumulation

Counter C

16 Bits counter 32 Bits counter
C0~C15
16 points
(general)

C16~C199
184

points (keep)

C200~C219
20 points
(general)

C220~C23
4 15points
(keep)

C235~C255
20points
(HS keep)

R D.V.Z
D0~D127
128 points
(general)

D128~D7999
7872

points (keep)

D8000~D819
5

196 points
(special,keep)

D8196~D8
255

59points
(special）

V0~V7
Z0~Z7
16points
(index)

Nested
Pointer

N0~N7 8
points
(master)

P0~P127 128 points
(jump,subroutine)

IO 口口~I5 口口 6
points (External interrupt)

Constant

K(10
digits) 16 bits-32768~32767 32bits-2147483648~2147

483647
H(16
digits 16 bits O~FFFF 32 bits 0~FFFFFFFF
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3 PLC Supported instruction
3.1 Basic Logic instructions
●The program step for soft element Y and general M is 1,for S and special auxiliary
relay M,timer T,counter C is 2，for Data register D ,index register V and Z is 3.

3.2 Step command instructions

Mnemonics Function Available soft
Elements Program Step

LD NO Logic operation begin X,Y,M,S,T,C 1
LDI NC Logic operation begin X,Y,M,S,T,C 1

LDP Rising Edge detection operation
begin X,Y,M,S,T,C 2

LDF Falling Edge detection operation
begin X,Y,M,S,T,C 2

AND NO series connection X,Y,M,S,T,C 1
ANI NC series connection X,Y,M,S,T,C 1

ANDP Rising edge detects series
connection X,Y,M,S,T,C 2

ANDF Falling edge detects series
connection X,Y,M,S,T,C 2

OR NO parallel connection X,Y,M,S,T,C 1
ORI NC parallel connection X,Y,M,S,T,C 1

ORP Rising edge detects parallel
connection X,Y,M,S,T,C 2

ORF Falling edge detects parallel
connection X,Y,M,S,T,C 2

ANB Series connection of parallel
circuit blocks 1

ORB Parallel connection of series
circuit blocks 1

OUT Coils drive Y,M,S,T,C Note 1
SET Action holding Y,M,S

Note 2RST Clear "Action holding",Register
to clear zero

Y,M,S,T,C,D,
V,Z

MC Connection command of common
series point

Y,M(Exclude
Special M) 3

MCR Eliminate command of common
series points 2

MPS Operation memory 1
MRD Memory read 1
MPP Memory read and reset 1
INV Inversion of operation result 1

PLS Rising edge differential output Y,M(Exclude
Special M) 1

PLF Falling edge differential output Y,M(Exclude
Special M) 1

OUT Counter coils drive C 32-bit counter:5
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●STL（Support 8 branches at most）RET

Mnemonics Function Available soft
Elements Program Step

SEL Step Action begin S 1
RET Step Action end / 1

3.3 Function instruction table( Compared with Mitsubishi PLC)

Sorts

FN
C instruction

mnemonics Function Support
commandNO

program
m
ing

flow
chart

00 CJ Conditional jump ★

01 CALL Subroutine call ★

02 SRET Subroutine return ★

03 IRET Interrupt return ★

04 EI Interrupt the license ★

05 DI Interruption forbidden ★

06 FEND Main program end ★

07 WDT Monitor timer ★

08 FOR Cycle range begin ★

09 NEXT Cycle range end ★

T
ransm

ission
and

com
parison

10 CMP Comparison ★

11 ZCP Region comparison ★

12 MOV Transfer ★

13 SMOV Shift Transfer ★

14 CML Reverse transfer ★

15 BMOV Transfer together ★

16 FMOV Multi-casting ★

17 XCH Exchange ★

18 BCD BCD exchange ★

19 BIN BIN exchange ★

Four
logical
operat
ions

20 ADD BIN addition ★

21 SUB BIN subtraction ★

22 MUL BIN multiplication ★

16- bit counter:3

SET Action holding Y,M,S Y,M：1
S,Special -M：2

RST
Clear "Action holding"，Current
value and
Register to zero

Y,M,S,T,C,D,
V,Z

Y,M:1
S，Special -M：2
T,C:2
D,V,Z Special
D:3

NOP No action 1
END Input,Output and Return to begin 1
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23 DIV BIN division ★

24 INC BIN plus 1 ★

25 DEC BIN minus 1 ★

26 WAND Logic word and ★

27 WOR Logic word or ★

28 WXOR Logic word XOR ★

29 NEG Complementary code ★

C
yclic

shift

30 ROR Rotate right ★

31 ROL Rotate left ★

32 RCR Carry rotate right ★

33 RCL Carry rotate left ★

34 SFTR Shift right ★

35 SFTL Shift left ★

36 WSFR Word move to right ★

37 WSFL Word move to left ★

38 SFWR Shift write ★

39 SFRD Shift read out ★

D
ata

processing

40 ZRST Batch reset ★

41 DECO Ze code ★

42 ENCO Coding ★

43 SUM ON digits ★

44 BON ON digits determination ★

45 MEAN Average value ★

46 ANS Signal alarm set ★

47 ANR Signal alarm reset ★

48 SQR BIN extraction of a root ★

49 FLT BIN Integer→floating conversion ★
H
igh-speed

processing

50 REF Input and output refresh ★

51 REFF Input refresh (with filter settings
52 MTR Matrix input
53 HSCS Compare High speed counting set
54 HSCR Compare High speed counting reset
55 HSZ Compare high speed counting zone
56 SPD Pulse density ★

57 PLSY Pulse output ★

58 PWM Pulse modulation ★

59 PLSR Acceleration and deceleration pulse
output

★

C
onvenient

instructions

60 IST Initialization state
61 SER Data retrieval ★

62 ABSD Cam control (absolute)
63 INCD Cam control (increment)
64 TTMR Teaching timer
65 STMR Special timer
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66 ALT Alternate output ★

67 RAMP Ramp signal ★

68 ROTC Rotary table control
69 SORT Data arrangement

Peripheralequipm
entI/O

70 TKY Numeric key input
71 HKY 16-key input
72 DSW Digital switch
73 SEGD 7-segment decoding ★

74 SEGL 7 segment code time display
75 ARWS Arrow switch
76 ASC ASCⅡtransformation
77 PR ASCⅡprintout
78 FROM BFM readout **2
79 TO BFM write **2

Peripheralequipm
ent

SER

80 RS Serial data transmission ★

81 PRUN 8-bit transmission
82 ASCI HEX to ASCⅡ ★

83 HEX ASC-HEX exchange ★

84 CCD Check code ★

85 VRRD Potentiometer readout
86 VRSC Potentiometer scale
87
88 PID PID operation
89

Floating
points

110 DECMP Binary floating point comparison ★

111 DEZCP Binary floating point zone comparison ★

118 DEBCD Binary floating point-decimal ★

119 DEBIN Decimal floating point-binary ★

120 DEADD Binary floating point addition ★

121 DESUB Binary floating point subtraction ★

122 DEMUL Binary floating point multiplication ★

123 DEDIV Binary floating point division ★

127 DESQR Binary floating point extraction ★

129 INT Binary floating-bin integer conversion ★

130 SIN Floating point SIN operation ★

131 COS Floating point COS operation ★

132 TAN Floating point TAN operation ★

147 SWAP Up and down byte conversion ★

Positioning

155 ABS ABS current value
156 ZRN Origin regression ★

157 PLSV Variable speed pulse output ★

158 DRVI Relative positioning ★

159 DRVA Absolute positioning ★
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C
lock

operation

160 TCMP Clock data comparison ★

161 TZCP Clock data zone comparison★ ★

162 TADD Clock data addition ★

163 TSUB Clock data subtraction ★

166 TRD Clock data readout ★

167 TWR Clock data write ★

169 HOUR Calculagraph ★

Peripheral
equipm

ent

170 GRY Gray code transformation ★

171 GBIN Gray code inverse transformation ★

176 RD3A Analog block readout **1
17 WR3A Analog Block Write **1

C
ontactcom

parison

224 LD= (Sl)=(S2) ★

225 LD﹥ (Sl)>(S2) ★

226 LD﹤ (Sl)<(S2) ★

228 LD◇ (Sl)◇(S2) ★

229 LD≥ (Sl)≥(S2) ★

230 LD≤ (Sl)≤(S2) ★

232 AND= (Sl)=(S2) ★

233 AND﹥ (Sl)>(S2) ★

234 AND﹤ (Sl)<(S2) ★

236 AND◇ (Sl)◇(S2) ★

237 AND≥ (Sl)≥(S2) ★

238 AND≤ (Sl)≤(S2) ★

240 OR= (Sl)=(S2) ★

241 OR﹥ (Sl)>(S2) ★

242 OR﹤ (Sl)<(S2) ★

244 OR◇ (Sl)◇(S2) ★

245 OR≥ (Sl)≥(S2) ★

246 OR≤ (Sl)≤(S2) ★

Note :
**1--When analog input and output is selected ,read and wrote data is used；
**2--Customized HMI PLC , is optional to add 1 rs485 com port, but it is not coexist
to built in rs232 com port.

Remarks :
1)Support 32-bit instructions,and adding P instructions;
2)When unsupported instruction is used,6056 fault will be detected；
3)“★”indicates the function instructions supported by MX2N series HMI PLC All in
one;
4)Instruction details refer to《Coolmay PLC Instructions Programming Manual
V20.51》
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3.4 Special relay & register function
3.4.1 Special relay function table

No Content No Content

M8000 Operation monitoring contact M8112 Optional 1 channel weighing
function start

M8001 Operation monitoring anti-contact M8113 Optional 1 channel weighing filter
function

M8002 Initialize pulse contact M8114 Optional 1 channel weighing fault
sign

M8003 Initialize pulse anti-contact M8115 Thermocouple open circuit fault

M8004 Error indication contact M8116
Optional 2-channel weighing

function Channel 1 Data overflow
(not available)

M8005 Random number generate relay M8117
Optional 2-channel weighing

function Channel 2 Data overflow
(not available)

M8006 Prohibit 6300-6399 fault flash "ERR" M8235 Drive high speed count C235 :Down
counting mode

M8008 Power-failure detection(0N /OFF) M8121~
M8124 RS and MODBUS use

M8011 10ms clock pulse M8129 Series 2 communication timeout flag
M8012 100ms clock pulse M8140 ZRN Instruction clear output is valid
M8013 1s clock pulse M8145 Prohibit Y0 pulse output
M8014 1m clock pulse M8146 Prohibit Y1 pulse output
M8015 Set clock M8147 Y0 in Pulse output
M8016 Clock display stopped M8148 Y1 in Pulse output
M8017 Clock ±30 s correction M8149 CAN communication timeout
M8018 Real clock flag M8150 CAN allowed working flag
M8019 Clock error flag M8155 Prohibit Y2 pulse output
M8020 Zero flag M8157 Y2 Pulse in output
M8021 Borrow flag M8158 Y3 Pulse in output
M8022 CF (carry flag) M8161 16-bit/8-bit switch flag

M8029 Instruction execution end M8168 SMOV instruct HEX processing
function

M8031 Non-Latch data clear M8170 X0 Pulse capture
M8032 Latch data clear M8171 X1 Pulse capture
M8034 Prohibit all outputs M8172 X2 Pulse capture
M8039 Constant scanning mode M8173 X3 Pulse capture
M8047 STL Effective monitoring M8174 X4 Pulse capture
M8048 S900-S999 -"ON " M8175 X5 Pulse capture
M8049 Valid signal alarms M8196 C251 C252 C254 2 multiplier
M8050 I0口口 Interruption prohibition M8197 C253 C255 2 multiplier flag
M8051 I1口口 Interruption prohibition M8198 C251 C252 C254 4 multiplier
M8052 I2口口 Interruption prohibition M8199 C253 C255 2 multiplier flag

M8053 I3口口 Interruption prohibition M8200~
M8234 C200-C234 count direction set

M8054 I4口口 Interruption prohibition M8235~
M8345 C235-C245 count direction set

M8055 I5口口 Interruption prohibition M8246~
M8255 C246-C255 count direction flag
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3.4.2 Special register function table
No Content No Content

D8000 Monitor timer setting
(Default 200) D8126 MODBUS Master/slave communication

delay time（1=1ms）

D8005 Low random number 16 bits D8127
MODBUS Master station

communication
real time（1=10ms）

D8006 High random number 16 bits D8128 MODBUS Master communication
maximum time （1=10ms）

D8007 Power-down hold D register end
address D8129 RS/MODBUS Master communication

timeout（1=10ms，Default 500）

D8008 Power-down detection time（Setting
value:1~100，Default 10ms） D8136 Y0 Y1 high-speed output count:32 bit

D8010 Scan time current value（0.1ms） D8140 Y0 pulse output counter register

D8011 Minimum scan time（0.1ms） D8142 Y1 pulse output counter register

D8012 Maximum scan time（0.1ms） D8145 ZRN\DRVI\DRVA command Y0 Y1
minimum speed

D8013-
D8019

Corresponding to seconds, minutes,
hours, days,

months, years, and weeks
D8146 ZRN\DRVI\DRVA command Y0 Y1

maximum speed

D8020 X0-X17 filter ratio（Setting：
0~60ms,Default 10） D8148 ZRN\DRVI\DRVA command Y0 Y1

acceleration and deceleration time

D8021 X20-X47 filter ratio（Setting：
1~60ms,Default 10) D8149 CAN Master/slave communicate

timeout（1=1ms）

D8028 Z0 Index register contents D8150 Master/Slaver Station No（0~32）

D8029 V0 Index register contents D8151 Slaves number（1~32,Default：8）

D8030-
D8038

Sampling address of Analog input
AD0-AD8 D8152 Shared register

number（1~32, Default：8）
D8050-
D8052

Sampling address of Analog input
AD9-AD11 D8153 CAN Communication baud rate

(20K~100K, Default：250K)

D8039 Constant scan time
(Unit: 1ms, Default 0) D8154 Y2 Pulse output count register

D8040-
D8047 1st to 8th activity STL status D8156 Y3 Pulse output count register

D8049 Minimum activity STL status D8159 ZRN\DRVI\DRVA command Y2 Y3
minimum speed

D8058
Optional 2-channel weighing

function Divisor of channel 1 data
(not available)

D8160 ZRN\DRVI\DRVA command Y2 Y3
maximum speed

D8059
Optional 2-channel weighing

function Divisor of channel 2 data
(not available)

D8162 ZRN\DRVI\DRVA command Y2 Y3
acceleration and deceleration time

D8090 Sampling filter numbers（0-22，
Default 0）

D8166 Y2 Y3 High-speed output count:32 bit

D8091 Thermocouple type（K-0,E-1,J-2） D8182 Z1 Address register contents

D8093 Thermocouple cold junction
temperature D8183 V1 Address register contents

D8094 1st thermocouple Temperature D8184 Z2 Address register contents
D8095 Temperature of second thermocouple D8185 V2 Address register contents
D8096 Analog DA0 Output data(0~4095) D8186 Z3 Address register contents
D8097 Analog DA1 Output data(0~4095) D8187 V3 Address register contents
D8112 Optional 1 channel weighing data D8188 Z4 Address register contents



Customized HMI PLC all in one programming manual

14

low

D8113 Optional 1 channel weighing data
high D8189 V4 Address register contents

D8114 Optional 1 channel weighing filter D8190 Z5 Address register contents

D8115
Optional 2-channel weighing

function filtering times (0-80) (not
available)

D8191 V5 Address register contents

D8116
Optional 2-channel weighing
function channel 1 data high

(not available)
D8192 Z6 Address register contents

D8117
Optional 2-channel weighing
function channel 1 data low

(not available)
D8193 V6 Address register contents

D8118
Optional 2-channel weighing

function communication 2 data high
(not available)

D8194 Z7 Address register contents

D8119
Optional 2-channel weighing
function channel 2 data low

(not available)
D8195 V7 Address register contents

D8120 Series 2 communication parameter
settings D8196 CAN Slave can't communicate 1~16

D8121 MODBUS RTU of series 2 slave
station（1~255） D8197 CAN Slave can't communicate 17~32

D8122 RS Remaining numbers instruction
sent D8198 CAN Slave summary no communicate

1~16

D8123 RS Instruction received numbers D8199 CAN Slave summary no communicate
17~32

D8200 CAN Communication time（1-1ms）
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4 Analog Usage
4.1 Analog input type

Input signal type Range Register
reading value Resolution Accuracy

total range
E type thermocouple Environment

temperature
~599.9℃

Room
temperature~5

999

0.1℃ 1%

K type
thermocouple

Environment
temperature
~999.9℃

Room
temperature~9

999

0.1℃ 1%

J type thermocouple Environment
temperature
~999.9℃

Room
temperature~9

999

0.1℃ 1%

Thermistor
NTC10K

-19.9~109.9℃ -199~1099 0.1℃ 1%

Thermistor
NTC50K

-40~199.9℃ -400~1999 0.1℃ 1%

Voltage analog 0~10V/0-5V 0~4000 2.5mV 1%

Current analog 0~20mA 0~4000 5uA 1%

4.1.1 Analog input reading
1. Analog input could be up to 8 channels, and the precision is in 12 bits.

NO Register reading
value

AD0 D8030
AD1 D8031
AD2 D8032
AD3 D8033
AD4 D8034
AD5 D8035

Calculate the input voltage formula:
Measure voltage = D803n (n = 0-7) * (VRF reference voltage / 4095);
Analog input sampling period: PLC scan cycles is fixed as 22.

2. 4.3inch,optional NTC analog read registers (AD0,AD2 are common port)

NO Register reading
value

1st （AD0,AD1） D8031
2nd （AD2,AD3） D8033

3. 7inch,optional NTC analog read registers (Occupy AD0,AD2,AD4 as common port

NO Register reading
value

1st （AD0,AD1） D8031
2nd （AD2,AD3） D8033
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3nd （AD4,AD5） D8035
4. 4.3inch Thermocouple analog read register:

Model
Register

reading value
Cold junction
temperature

Thermocouple
Sampling filter times4.3inch（AD0,AD2 are

common port）
1st （AD0,AD1） D8094

D8093 D8090(0-22,default:0)
2nd （AD2,AD3） D8095

4.2 Analog output type.

Output signal type Range Register
reading value

Voltage analog 0~10V/0-5V 0~4095

Current analog 0~20mA 0~4095

4.2.1 Analog output reading
Analog output could be up to 2 channels, and the precision is in 12 bits.

NO Register reading
value

DA0 D8096
DA1 D8097

* When PLC is in “STOP”, D8096 D8097 is automatically set as 0 , DA output is also 0.

* When data setting of analog output is incorrect, 6712 fault will be defected, and DA output
is 0.

4.3 Weighing function / load cell
●7inch is optional to add 1 channel weighing function (which occupy AD0-AD2),
and it is converted into a high-precision 24-bit AD/AI designed by an electronic scale.
It supports selection of filtering and setting of filtering times, and has a fault detection
relay, 64 gain, and a fixed rate of 80Hz;

●Special Registers as below：
M8112 Optional 1 channel weighing function Start
M8113 Optional 1 channel weighing filter function Start
M8114 Optional 1 channel weighing failure flag
D8112 Optional 1 channel weighing data low bit
D8113 Optional 1 channel weighing data high bit
D8114 Optional 1 channel weighing filter times
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●Wiring：

●Program, please refer to website: Weighing Case

http://coolmay.com/Download-178-36-41.html
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5 Random number instructions
1) Random number related register: Start convert relay-M8005

Random number save register-D8005 (low) D8006 (high)

2) If you need to generate the random number, just need to set M8005 ON in the program.
When the random number is generated and be saved to D8005 D8006, M8005 will be set OFF
automatically.

3) Therefore, M8005 is set from OFF to ON, then start the random number conversion.
And M8005 turn from ON to OFF, then the conversion is completed.

4)
Example：LDP M0 M0 non-edge pulse

SET M8005 SET M8005
LDF M8005 M8005 ‘s Lower edge －Conversion completed

DMOV D8005 D0 Extract random numbers to D0 D1
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6 High speed counter application
6.1 Inside high speed counter input distribution table

Counter
Type Counter

Model
Input assigned

Single Phase
single count
input

X000 X001 X002 X003 X004 X005 X006 X007
C235 U/D
C236 U/D
C237 U/D
C238 U/D
C239 U/D
C240 U/D
C241 U/D R
C242 U/D R
C243 U/D R
C244 U/D R S
C245 U/D R S

Single Phase
double count
input

C246 U D
C247 U D R
C248 U D R
C248(OP
)*1 U D

C249 U D R S
C250 U D R S

Double phase
double count
input

C251 A B
C252 A B R
C253 A B R
C253(OP
)*1 A B

C254 A B R S
C254(OP
)*1 A B

C255 A B R S

U: add counter input D: Delete counter input
A: A phase input B: B phase input
R: External reset input S: External start input

● Input X000~X007, as shown in the above table, corresponding to each high-speed
counter number. Inputs X000~X007 cannot be used repeatedly by high-speed
counters. They can be used for general input when the input terminals are not used as
high-speed counters.
● The input X000~X007 cannot be reused. For example, once C251 is used, X000
and X001 are occupied, so C235, C236, C241, C244, C246, C247, C249, C252, C254
and interrupt input pointers *I00, *I01 and corresponding input SPD instructions
cannot be used.

6.2 High speed counter input instructions
1) Maximum response frequency of C251 C252 C254 (AB phase): 60KHz;
2) Maximum response frequency of C253 C255 (AB phase): 60KHz;
3) Maximum response frequency of C235 C241 C244 C238 (single phase): 60KHz;
4) Other high-speed counter’s highest response frequency: 10KHz;
5) High speed counter of the AB phase can be set to 2 times and 4 times frequency
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(setting is valid only for OUT drive same cycle):
** When M8196-ON, C251 C252 C254 count pulse is 2 times frequency;
**When M8197-ON, the C253 C255 count pulse is 2 times frequency;
** When M8198-ON, C251 C252 C254 count pulse is 4 times frequency;
**When M8199-ON, C253 C255 count pulse is 4 times frequency;
For example: If you use an AB phase encoder, it is 1024 pulse inputs in one turn. If
not set the frequency multiplier, then adjust the counter count 1024 (the original
FX1N does not support frequency multiplier, but the FX3U can set 4 times frequency),
If you set 2 times the frequency, then turn the counter to count 2048; if you set 4
times, then turn the counter to count 4096.

Usage instruction:

** Other usage are consistent with the original FX1N, refer to FX programming manual;
** If high-speed input function is not selected, Then SPD, external interrupt, and C235~C255
high-speed counter cannot be used normally.
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7 Pulse capture function application
1) Supports the pulse capture function of X0-X5, corresponding to: X0-M8170, X1-M8171,
X2-M8172, X3-M8173, X4-M8174, X5-M8175.

2) Using the pulse capture function, firstly you need to use the EI instruction. The example is
as follows:

*EI : Interrupt is allowed.
M8170 :After ON It needs to be reset to be ON again.
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8 High speed pulse output application
1) Normally with 4 high-speed pulses (Y0- Y3,10khz), Y0 and Y1 can output up tp 200KHZ
at the same time, and Y2 and Y3 can output up to 100KHz at the same time;

2) Regarding the positioning command with direction output: after driving, the direction
output delay 20ms before outputting the pulse;

3) Special components used for pulse instructions:
Y0 Y1 Y2 Y3

Min output
frequency(default:0) D8145 D8145 D8159 D8159

Max output
frequency

D8146
D8147

D8146
D8147 D8160 D8160

Acceleration time
（default：100ms） D8148 D8148 D8162 D8162

Output pulse stops
immediately M8145 M8146 M8155 M8156

In outputting pulse M8147 M8148 M8157 M8158
Output pulse
accumulation

D8140
D8141

D8142
D8143 D8154 D8156

Output pulse
accumulation

D8136
D8137

D8166
D8167
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9 Optional com port instructions
9.1 Function Description
1) 1 RS485 communication port is optional, but can not coexist with its own 232 port.
2) Support exchange between Mitsubishi programming protocol and MODBUS-RTU
protocol. (When PLC stops, it will be back to Mitsubishi programming protocol automatically;
When PLC start, the protocol depends on D8120.)
3) Communication data of optional communication port is set in the D8120 and it will take
effect after PLC runs (the second modification could be made until the STOP-RUN is valid
again, the D8120 is reset to 0 when the PLC is in STOP), and the MODBUS-RTU slave
station number is set in the D8121 ( Range 1~255).
4) Use FROM to read slave data when using MODBUS-RTU master,TO to write slave data
(supports broadcast sending function)
5) Set the optional communication port to MODBUS-RTU protocol. the baud rate of slave is
9600 . as follows:

9.2 Modbus-RTU Protocol special registers & relays
Master：
M8121-Master data transmission.
M8122-Master receive Slave data, check error.
M8123-Master receive completed signal
M8124-Master receive broadcast signal
M8129-Communication timeout signal
D8120-Communication parameter and function
D8126-Sending interval(1=1ms,default 20ms，interval between two communication)
D8122-Station number with communication timeout
D8123-Real receiving time（1=10ms）
D8124-Max receiving time(1=10ms)
D8129-Receive timeout setting（1=10ms，default 50=500ms，Time from sending completed
to receiving completed）

Slave:
D8120-Communication parameters and function
D8121-Slave address（Range：1~255）
D8126-Respond overtime（1=1ms，Default 5ms）
Note: 1.M8121, M8122, M8123, M8124 are only for internal use. Don’t write using
MODBUS-RTU master station.

2.When D8129 receives the timeout, please set according to the actual setting. When
the setting time is too long, if there is a slave communication failure, the waiting time for
re-communication (namely D8129) will be very long.

9.3 D8120 Parameter and Function setting
D8120 Setting function diagram as below: (D8120 communication parameter selection
register)

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0
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Bit number Name Content

b0 Data length 0:7 bit
1:8 bit

b2b1 Parity
00:None
01:Odd
11:Even

b3 Stop bit 0:1 bit
1:2 bit

b7b6b5b4 Baud rate

0011:300bps
0100:600bps
0101:1200bps
0110:2400bps
0111:4800bps
1000:9600bps
1001:19200bps
1010:38400bps
1011:57600bps
1100:115200bps

b8 Forbidden Set 0
b9 Forbidden Set 0

b12 b11 b10 Protocol
selection

000：Mitsubishi Programming port protocol
001：RS Protocol
010：MODBUS-RTU Slave protocol
011：MODBUS-RTU Master protocol

b13 Forbidden Set 0
b14 Forbidden Set 0
b15 Forbidden Set 0

*1：The start and end characters can be set by user
*2：D8121 is MODBUS-RTU slave station number setting
*3：When the data bit is in 7 bit,the parity can’t be selected---No checking. (6038 failure).

*Mitsubishi Programming port protocol：Data length 7,stop bit 1,Parity EVEN is fixed,the rate
can be set；
*MODBUS-RTU protocol：data length, stop bit, parity, rate can be set;
*RS instruction： Data length, stop bit, parity, rate, start character, and end character can all be
set.

9.4 Modbus-RTUMaster station instructions
Master read slave data usage instruction

* Transfer the data of register from address 0 of 1st station to D0

M1--low 8 bits indicate the slave address, high 8 bits indicate the sent instruction;
Such as: H301-command 03 (read register instruction), slave address 01; if the high 8 bit is 0,
then the command is default as 03;
M2--slave element address; (Slave address , refers to slave element address table);
D - master station data register, this register holds the data which read from the slave station;
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N -- read data length (1~64);

Master write slave data usage instruction

* Write the data of D0 to the register with the 1st slave in address 0

M1--low 8 bits indicate the slave address, high 8 bits indicate the sent instruction;
Such as: H601-command 06 (read register instruction), slave address 01; if the high 8 bit is 0,
then the command is default as 06;
M2--slave element address; (Slave address, refers to slave element address table);

If the address is set to 0, it means to write data to all slave stations;
D - master station data register, this register holds the data which read from the slave station;
N --written data length;

When using commands 05 (write bit) and 06 (write register), no matter what the length is
set, press 1 to operate.

When using H10(K16) to write multi-bit registers, the data length(1~64).

Special Note:
1. FROM and TO can be used many times in the program. When multiple instructions

are executed at the same time, the system will communicate in turns. If the communication is
overtime, M8129 set “ON” and reports “6306 fault” and exits from this communication, and
records this overtime station number in the D8122 register,execute the next communication
instructions;

2. The FROM/TO instruction cannot be used with the RS instruction in the program at
the same time, reporting 6609 failure;

3. The data length maximum of the FROM/TO instruction: bit (1~64), register (1~64);
4. The communication parameters of the master station and the slave station must be set

same to communicate, such as data length, parity, stop bit, and rate;
5. When using the 05 command to set the slave station component, such as: TO H501

K4000 D0 K1—Set the M0 state of slave No. 1. If D0 is equal to 0, slave M0 is OFF; when
D0 is non-zero, slave M0 is ON;

6. When using the TO command, you can send instructions to all slaves, and only need
to set the slave address to 0.

For example, TO H600 K0 D0 K3: Write D0, D1, D2 of master station to register
addresses 0, 1, 2 of all slaves.

D8129—Communication timeout setting, default 500ms;
setting suggestion: set D8129 larger,when written program communication is normal, run a
period, monitor the value of D8124, D8129 equals D8124 plus 3 (only for reference );

Note: 1) The function needs to be enabled in IO setting and activation software,
otherwise it will report 6506 fault (unsupported instruction) when using FROM/TO
instruction;
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9.5 Modbus-RTU Protocol slave station element address
Bit

component
Addres

s
Bit

component
Bit

component
Bit

component
Addres

s
Bit

component
Addre
ss

Bit
component

Addr
ess

X0 0 X40 32 Y0 300 Y40 332 S0-S999 1000-1
999

X1 1 X41 33 Y1 301 Y41 333 T0-T255 2000-2
255

X2 2 X42 34 Y2 302 Y42 334 C0-C255 3000-3
255

X3 3 X43 35 Y3 303 Y43 335
M0-M1535：

FX1N
4000-5
535

X4 4 X44 36 Y4 304 Y44 336
M0-M3071：

FX2N
4000-7
071

X5 5 X45 37 Y5 305 Y45 337

X6 6 X46 38 Y6 306 Y46 338 Bit
component

Addres
s

X7 7 X47 39 Y7 307 Y47 339 D0-D5999 0-5999

X10 8 X50 40 Y10 308 Y50 340 T0-T255 8000-8
255

X11 9 X51 41 Y11 309 Y51 341 C0-C255 8300-8
555

X12 10 X52 42 Y12 310 Y52 342

Communication
parameters:

1. Communication
parameters,refer to
above D8120 set;
2. Inspection: N or

O or E;
3. Data bit: 8 or 7;
4. Stop bit: 1 or 2;
5, ID is set in
D8121 (1~255);

MODBUS-RTU

X13 11 X53 43 Y13 311 Y53 343

X14 12 X54 44 Y14 312 Y54 344

X15 13 X55 45 Y15 313 Y55 345

X16 14 X56 46 Y16 314 Y56 346

X17 15 X57 47 Y17 315 Y57 347
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instruction:
1,Read bit
operation

instruction: 01, 02;
2,Write bit
operation

instructions: 05;
3. Read register
instruction: 03,04;
4, Write register
instructions: 06;
5, Write multi-bit

register
instructions: 16

(H10)

Note: The
maximum registers
could be written
and read at the
same time is 64.

X20 16 X60 48 Y20 316 Y60 348

X21 17 X61 49 Y21 317 Y61 349

X22 18 X62 50 Y22 318 Y62 350

X23 19 X63 51 Y23 319 Y63 351

X24 20 X64 52 Y24 320 Y64 352

X25 21 X65 53 Y25 321 Y65 353

X26 22 X66 54 Y26 322 Y66 354

X27 23 X67 55 Y27 323 Y67 355

X30 24 X70 56 Y30 324 Y70 356

X31 25 X71 57 Y31 325 Y71 357

X32 26 X72 58 Y32 326 Y72 358

X33 27 X73 59 Y33 327 Y73 359

X34 28 X74 60 Y34 328 Y73 360

X35 29 X75 61 Y35 329 Y75 361

X36 30 X76 62 Y36 330 Y76 362

X37 31 X77 63 Y37 331 Y77 363
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9.6 RS Protocol special registers & relays instructions
M8121：RS instruction is being sent
M8122：RS instruction is in sending
M8123：RS instruction receiving signal
M8124：RS instruction is in receiving
M8129：Communication timeout signal
D8122：RS instruction sends data remainder
D8123：Numbers of RS instruction received
D8127：Real-time receiving time（1=10ms）
D8128：Max receiving time （1=10ms）
D8129：RS instruction reception timeout setting（1=10ms，default 50=500ms）

Note:
Max data sent and received by RS Instruction is 140. (If over, report 6706)

9.7 CAN communication protocol instruction

9.7.1 Function description
1) CAN function can set 1 master, up to 32 slaves (setting range: 1~32), and the maximum
number of registers shared by each station is 32 (setting range: 1~32);
2) CAN function communication baud rate can be set: 20K, 50K, 80K, 100K, 125K, 200K,
250K, 400K, 500K, 600K, 800K, 1000K (if the unsupported baud rate is set, the default is 250K
automatically) ；
3) The shared register of the master and all slaves is shared with each other, and each station can
share up to 32 registers. For details, see four (master-slave shared address table)；
4) Slave/master address repeated fault detection,there is corresponding fault,check the fault
description of the main manual
5) Current CAN communication function only supports the MX2N series PLCs to be
interconnected with each other, and does not support networking with other CANs;
6) Using CAN networking is fast, simple and convenient, only need to set a few registers;

9.7.2 Register and relay description

Master
M8150-CAN allow work
M8149-Communication timeout flag(CAN occurs “does not communicate” or “timeout flag”.
After this flag is ON, it needs to be manually turned OFF in the program).
D8149-Communication timeout parameter （1=1ms,Default 50ms）
D8150-Master set（0=master）
D8151-Slave numbers（1~32,Default 8）
D8152-Shared register numbers（1~32,Default 8）
D8153-Communication baud rate（20K~1000K,Default 250K）
D8196-uncommunicated slave（1~16）
D8197-uncommunicated slave（17~32）
D8198-uncommunicated slave summary（1~16）
D8199-uncommunicated slave summary（17~32）
D8200-Maximum time to communicate with the slave successfully（1=1ms）

Slave
M8150-CAN allow work
M8149-Communication timeout flag(CAN occurs “does not communicate” or “timeout flag”.
After this flag is ON, it needs to be manually turned OFF in the program).
D8149-Communication timeout parameter （1=1ms,Default 60ms）
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D8150-Slave address set（1~32）
D8152-Shared register numbers（1~32,Default 8）
D8153-Communication baud rate（20K~1000K,Default 250K）
D8196-uncommunicated slave（1~16）
D8197-uncommunicated slave（17~32）
D8198-uncommunicated slave summary（1~16）
D8199-uncommunicated slave summary（17~32）
D8200-Maximum time to communicate with the slave successfully（1=1ms）

Note：
1. Flag of D8196 D8197 can’t communicate with slave is 500ms automatic reset once.
2. Uncommunicated Slave summary of D8198 D8199,after power-on,can’t communicate with
slave summary.
3. CAN related register parameters, after setting,need to be powered off firstly to execute
according to the new data（(if the parameters are set by the program, please turn off the power
after the PLC is running, and then send power again, then CAN will start or start with new
parameters);
4. Communication timeout setting of master and slave: The D8149 of the slave is recommended
to be larger 10ms than the master (if master is 50ms, then slave is 60ms).

9.7.3 Description of register can’t be communicated

Note:
1. When the corresponding bit of the above register is 1, it indicates that the address corresponding
to the bit is not communicated or the communication error occurs.
2. D8198 D8199 is,slave record that has not been communicated after the main board is powered
on,reset after power off;

9.7.4 CAN communication speed and distance

9.7.5 Master-Slave shared register table

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0
D8196 #16 #15 #14 #13 #12 #11 #10 #9 #8 #7 #6 #5 #4 #3 #2 #1
D8197 #32 #31 #30 #29 #28 #27 #26 #25 #24 #23 #22 #21 #20 #19 #18 #17

Baud rate Distance（m） Minimum diameter（m㎡） Maximum access
points

1000Kbps 30 0.3 18

500Kbps 80 0.3 32

250Kbps 150 0.3 63

125Kbps 300 0.5 63

100Kbps 500 0.5 63

50Kbps 1000 0.7 63

D8150 Start End Description D8150 Start End Description

0 D1000 D1031 Master shared 17 D1544 D1575 #17 shared register
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Note:
The start address of the register corresponding to the above #number is fixed, and the end address
is determined by D8152 (such as D8152=2, then there are only 2 shared registers of the master and
slave, master station:D1000-D1001, #1 slave station: D1032-D1033)

register

1 D1032 D1063 #1 shared register 18 D1576 D1607 #18 shared register

2 D1064 D1095 #2 shared register 19 D1608 D1639 #19 shared register

3 D1096 D1127 #3 shared register 20 D1640 D1671 #20 shared register

4 D1128 D1159 #4 shared register 21 D1672 D1703 #21 shared register

5 D1160 D1191 #5 shared register 22 D1704 D1735 #22 shared register

6 D1192 D1123 #6 shared register 23 D1736 D1767 #23 shared register

7 D1224 D1255 #7 shared register 24 D1768 D1799 #24 shared register

8 D1256 D1287 #8 shared register 25 D1800 D1831 #25 shared register

9 D1288 D1319 #9 shared register 26 D1832 D1863 #26 shared register

10 D1320 D1351 #10 shared register 27 D1864 D1895 #27 shared register

11 D1352 D1383 #11 shared register 28 D1896 D1927 #28 shared register

12 D1384 D1415 #12 shared register 29 D1928 D1959 #29 shared register

13 D1416 D1447 #13 shared register 30 D1960 D1991 #30 shared register

14 D1448 D1479 #14 shared register 31 D1992 D2023 #31 shared register

15 D1480 D1511 #15 shared register 32 D2024 D2055 #32 shared register

16 D1512 D1543 #16 shared register
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9.7.6 Setting example of communication program
1) Master communication program

2)Slave communication program
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9.7.7 Test program description
1) Require 3 plc,one for master,one for station #1,one for station #2.
Shared registers: 8,
Communication baud rate: 250K;

2) If can’t communicate,the ERR will flash, please use the “programming software -
diagnosis” to check the error code;
3) There are three programs in the test program folder,one for master,one for station
#1,one for station #2 (after downloading the program, set the PLC to run, power off to
update CAN parameters, and then send power on, CAN runs according to the new
parameters);
4) After the communication cable is connected, after downloading all the programs,
all three PLCs are RUN;
5) The X0-X3 status of the master is output to the Y0-Y3 of the station #1,#2;
6) The X0-X3 status of station #1 is output to the master and the Y4-Y7 of station #2;
7) The X0-X3 status of station #2 is output to the master and the Y10-Y13 of station
#1;

Test:
After the communication between the three Plcs is normal, disconnect the
communication cable of the station #2, monitor the master and the D8196 of the
station #1 (should be H0002- indicates that the station #2 is not communicated), and
monitor the D8196 of the station #2 (should be H0002- Indicates that itself can’t
communicate with master)
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10 Fault detection

Sorts Error Error contents Resolution

PLC hardware
error

M8061(D8061)
Running stop

0000 No abnormality

6101 Power failure data error
Check the power failure detection
circuit, CPU internal FLASH is

damaged
6105 Monitor action (Internal watchdog act)

Increase D8000 setting value, or
check procedures

6106 Logical error Contact supplier

Serial 2/CAN
Error

M8063(D8063)
Running continue

0000 No abnormality

6306 Receive data timeout
Detect communication line and

D8129 setting

6307 Unopened serial 2 use RS,FROM,TO instructions Open serial 2 communication in
IO parameter software

6308 D8120 data bit/ check bit selection error 7-bit data can’t select “No test”
6309 D8120 check selection error Check the selection value error

6322 D8120 doesn’t open RS instructions Pls set D8120 Reuse RS
instruction correctly

6330 D8120 Parameter setting error

6331
MODBUS-RTU Master doesn’t support function

code
Reset FROM and TO Function

code

6332
D8120 doesn’t open MODBUS-RTU Master

station
Set D8120 reuse FROM and TO

instruction correctly

6333 FROM/TO receive slave data check error
Check whether the

communication parameters of the
master and slave stations are

6334
FROM/TO receive slave station number is

inconsistent with function code
6335 FROM slave address error FROM slave address can’t be 0

6336
FROM/TO instruction’s read/write

data length error
Read/Write length should be 1- 64

6340 Serial 1 DMA transmission error
6341 Serial 1 DMA receive error
6345 Serial 2 DMA transmission error
6346 Serial 2 DMA receive error

Parameter error
M8064(D8064)
Running stop

0000 No abnormality

6401 Program and number check error

1, The program is modified
maliciously

or downloaded is unfinished;
2,CPU internal program FLASH

6409 IO function parameter and number check error
IO function parameter download

is incomplete or FLASH is
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**When an error occurs, use the diagnostics on the PLC programming software GX Developer
and GX Works2 software menu to diagnose the PLC error code and program steps;

6410
MODBUS master function is not opened on using

TO/FROM instruction
Please enable the MODBUS
master function in the setup

6411
Using the RD3A/WR3A instructions can’t open

AD/DA enhancement function
Please enable AD/DA

enhancement in the setup

Grammatical
error

0000 No abnormality
6504 Pn/In/High speed label repeat
6505 Component range is exceeded
6506 Use unsupported instructions
6507 Use incorrect labels（like, P63）
6510 MC number size is incorrect

Loop error

M8066(D8066)

Running stop

0000 No abnormality
6603 Use MPS more than 12 times

6605
1,STL continue use times is over 9 times

2,RET appears without using STL

6606
1, I (interrupt) IRETSRET in the main program

2,No IRETSRET in the program.

6609 Others Whether to use FROM/TO and
RS instructions at same time

6614 Less MPS
6615 Less MPP
6619 I MC MCR IRET STL RST in FOR~NEXT
6623 No MC instruction

6625

1,The initialization step is out of range (S0-S9)
2, The number of STL Sn used is more than 2

3, The range of STL Sn Sn is more than S899

6626 MC, MCR, SRET, I (interrupt), IRET in STL
6627 No RET instruction after STL
6630 CALL SRET relationship is incorrect

Mathematical

error

OM8067(D8067)

Running

continue

0000 No abnormalityv
6701 CALL、CJ have no objects

6706 The instruction component address or value
range is exceeded

6710 SFWR（P）instruction component 1 and
component 2 is same

6711 Analog input AD range setting error
6712 Analog output DA range or data seeting error
6713 Thermocouple open circuit No connect thermocouple

6715 NTC open circuit No connect NTC Thermistor
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Note:
When the power is turned off, the ERR light is long on and the program is not allowed to be
downloaded.
**If you need to reset the ERR light, after troubleshooting:
1. Turn the RUN switch to STOP and pull it back to RUN;
2. After the main board is powered off, send power until ERR light is off.
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11 HMI (Human Machine Interface)

11.1 How to install mView software
(Please go to the official website :WWW.COOLMAY.COM to download the

latest version)
This chapter will detaily introduce the installation process of mView software.

■ Hardware requirements
Basic hardware requirements for installing mView editing software are as follows:

1. Personal computer host: It is recommended to use a CPU of 80486 or higher.
2. Memory: It is recommended to use more than 128MB RAM to expand the

memory.
3. Hard disk: The hard disk must have more than 100MB of space.
4. Display: General VGA or SVGA display card.
5. Mouse: Use a Windows compatible mouse.
6. Printer: Use a Windows compatible printer.

Before you install it, please check whether the computer hardware is as above or
higher. In order to avoid problems with hardware incompatibility, please use the
recommended specifications as much as possible. If you have any questions, please
contact our customer service.

■ Software source
You can enter our company's websiteWWW.COOLMAY.COM to obtain the

latest version of the software.

■ Installation steps (take the simplified Chinese version of mView as an example),
note that "mView ***" software version is subject to the official website.
Select mView 13802.exe in the installer window to start the installer and start the
installation;

http://www.coolmay.com
http://www.coolmay.com
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●Set the storage path of the installation file, select the default, or enter the address, or
click the [Browse ...] button to select the address, and then click the [Next] button;

●Set the name of the saved folder. It is recommended to select the default and click
the [Next] button directly.
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●Choose whether to create a desktop shortcut icon, and then click the [Next] button.

●Confirm the installation path and other installation information, and then click the
[Install] button to install.



Customized HMI PLC all in one programming manual

7

●The installation process is shown below:

●Click [Next] to install the driver wizard
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● The driver installation is completed

 Finally,click [Finish] to complete the installation.
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11.2 How to open mView software
After the installation of mView software is completed, a shortcut will be placed on the

desktop ，At the same time, the corresponding mView program group has been
added to the Windows start menu:

Choose one of the above two methods to open the mView programming software.
When the application is started, a startup window will pop up, as shown in the
following figure.
After the software is opened, it will be checked according to the menu bar [View]->[
Option...]->[File]->Program start automatically open file, to determine whether to star
t the last project file when the software is opened, or not to open any file.
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11.3 Build New HMI Program
To create a new project, you can directly click [New File] under [File] menu, Or

click the icon in the toolbar, Or use the hot key Ctrl + N set by the system. The
dialog box shown below is displayed:
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Title: Enter the name of the new project;
Model: select the model of the human-machine interface (HMI), (4.3inch is

TK6043FH; 7inch is TK6070fh);
Direction: select whether the editing screen is displayed horizontally or

vertically;
Description: Enter a help description for the newly created project, or choose

not to enter it.
After completing the project-related information input, click the [OK] button to

enter the communication information setting dialog box, as shown in the following
figure. For specific settings, please refer to section 2.4.2 Communication Management
in Coolmay TK Series HMI User Manual.

https://en.coolmay.com/webdown/Coolmay%20TK%20Series%20HMI%20User%20Manual.pdf
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11.4 Introduction of mView software interface

mView editing interface layout:

●Title bar: Displays the currently opened project path and file name, window
number, and window name.
●Menu bar: A menu that displays various commands of CoolMayView. These
menus are pull-down menus.
●Standard toolbar: Shortcut buttons for placing some commands. Corresponding
buttons and editing tools for displaying files, editing, printing and other functions.
●Design components: Command buttons for component objects.
●Screen management: The management window of the screen used by the project.
●Communication management: engineering designers to manage, set up a window to
communicate with PLC or other serial devices.
●Label management: Set labels for system variables and external variables to
facilitate users to quickly find the corresponding variables.
●Status bar: Displays the current operation status, human-machine interface
parameters, and communication equipment.
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12 HMI program simulation and download

12.1 Program simulation
mView provides the function of simulating directly on the PC. You can use this

function to simulate the actions performed on HMI after planning HMI. On the one
hand, it increases the convenience of finding program errors, and on the other hand, it
can save downloading to the time HMI can connect to the controller. The simulation
function of mView is divided into two types: [On-Line Run] and [Off-Line Run], as
shown in the figure below.

12.1.1 On-Line Run
This function needs to be connected to the controller, and the program will

modify the corresponding contacts and registers set by the controller during execution.
It can be used to verify whether the planned program can normally act on the
controller.

Before [On-Line Run], you need to set up the communication, as shown in the
figure below:
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Among them, COM1 and COM2 on the left of [Communication Setup] refer to
the communication ports on HMI, and the setting on the right is the set of
communication ports designated by the user on the PC side to simulate the
sex-corresponding communication ports of HMI side ,As shown below:
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12.1.2 Off-Line Run
This function does not need to be actually connected to the controller, it can be

used to test the normal operation of the program and the verification of various
functions.

12.2 Program download and update O.S. version
After using the PC to simulate and verify that the program is correct, you can

start downloading to the HMI and directly use HMI to connect to the controller.

12.2.1 Download to HMI
Before downloading the program to HMI, you need to make communication

settings first, please select [HMI]→[Setup]→[Communication Setup], as shown in the
figure below:
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Specify the communication port of the PC in the [Upload/Download] of the
communication setting window, that is, the port where the download cable is
connected to the PC. For example, COM3, you can select [Use fixed communication
rate] in conjunction with HMI [download screen], or let the PC automatically try to
download at different rates.

Then select [HMI] → [Download to HMI], and then start to download the HMI
program to the HMI, as shown below:

12.2.2 Save as HMI program
In addition to directly downloading the planned program to HMI, mView also

provides the user to save the planned program into a specific file (*.vho). For
downloading and using in the future, it should be noted that this file is only for
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downloading and its content cannot be modified.
Select [HMI]→[Save project as file...] to save the project as a special file for

man-machine of type vho, as shown in the figure below:

Then you need to download this program to the HMI, select [Tool]→[Download
HMI Program], as shown below, you can download this program to HMI.
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12.2.3 Update HMI OS
Generally speaking, when the new version of mView software is updated, it will

be matched with the corresponding version of the OS. This OS supports the old
version of the planning software downwards, but if the user wants to use the functions
provided by the new version of the planning software, the new version must be
matched OS and HMI OS are updated as follows.

Step 1: Select [Tools]→[Update HMI OS].
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Step 2: Select the OS version to be updated (it is recommended to update with
the planning software version used).

Step 3: Start downloading. (Note: During the OS download process, the HMI
must not be powered off!)
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Step 4: After the download is complete, restart the power of the HMI.

12.3 Program upload
Use this function to upload the program in the man-machine back to the PC and

save it as an HMI program for later downloading or editing by the user.
12.3.1 Upload HMI program

Select [Tool]→[Upload HMI Program] to upload the program from the HMI
back to the PC. After the transfer is complete, the user will be asked to save the file as
a dedicated file named vho, as shown in the figure below:
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To make the uploaded program editable, you must add the decompiled
information before downloading the program, otherwise the uploaded program can
only be used for downloading, and the user cannot edit it.

Select [View]→[Option(H)]→[File], and tick [Add Decompiled Information].
As shown below:
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12.4 More details, refer to Coolmay TK

Series HMI User Manual

https://en.coolmay.com/webdown/Coolmay%20TK%20Series%20HMI%20User%20Manual.pdf
https://en.coolmay.com/webdown/Coolmay%20TK%20Series%20HMI%20User%20Manual.pdf
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Appendix Version Change Record

Date
Version

after change
Content changes

August 2021 V21.81
 1.2 Model specifications Updated the table content
 1.3 Structure description and dimensions Modified
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